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BLOCK  4 POWER POINT PRESENTATION 
AND MULTIMEDIA 

This is the fourth block of the course “Computer Application in Business”. 
This block will familiarize you with PowerPoint application, multimedia, 
YouTube, video-making and creating business presentations. This block will 
also expose you to the working with power point, making of the power point 
presentation, their various applications, usage of multimedia, video and 
YouTube etc. This block is structured to cover these related aspects. The 
block on the theme “PowerPoint Presentation and Multimedia” comprises of 
three units, the detail of which is mentioned below: 

Unit-13: The very first unit of this particular block focuses on working 
on the basic of PowerPoint. The unit extends further on learning how to 
use different multimedia elements in our presentations to make it more 
informative and effective. 

Unit-14: This unit focuses on the usage of various features of 
multimedia, video making and YouTube in business.  It familiarizes the 
learner with the application of multimedia, graphics and animation. It 
also explains the usage of YouTube in business, video making and how 
to create YouTube personal channel etc. 

Unit-15: This unit familiarise the learners with various elements and 
features of PowerPoint. It explains step by step how the PowerPoint 
presentations are made. Apart from the PowerPoint, the unit also 
explains making and significance of research proposal, business 
presentation and project presentation. 
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UNIT 13 WORKING WITH POWERPOINT 

Structure 

13.0 Objectives 

13.1 Introduction 

13.2 PowerPoint Basics- Inserting a New Slide 

13.3  Slide Views  

13.4  Inserting a Graph & Diagram 
 13.4.1 Insertion of Graph/Chart 

 13.4.2 Insertion of a Diagram 

13.5  Inserting Picture 

13.6  Inserting Sound 

13.7  Inserting Video 

13.8  Saving PPT Files in External Memory & Cloud 

13.9  Let Us Sum Up 

13.10 Key Words 

13.11 Terminal Questions 

13.0 OBJECTIVES 

After studying this unit, you should be able to: 

insert a new slide in your presentation, 

explain different slide views, 

insert graphs and diagrams in slides, 

insert pictures in slides, 

insert sound and video in slides, and  

copy presentation in Pen Drive/Compact Disc (CD). 

13.1 INTRODUCTION 

A PowerPoint is a software from Microsoft, which is used to create 
presentation. Generally, a presentation is created by logical collection of 
individual slides that contain information on a specific topic. PowerPoint is 
used for preparing range of presentations on various topics including 
educational presentation, business presentation, social awareness 
presentations etc. 

PowerPoint allows us to add different elements such as images, and 
audio/visual features in our presentation. These elements are called 
Multimedia Element. To make a multimedia presentation, we should use at 
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least one of the following elements: Image, Audio, Video, and Animation. In 
this unit, you will learn working on PowerPoint. Also, you will learn how to 
use different multimedia elements in your presentations to make it more 
informative and effective. 

13.2 POWERPOINT BASICS-INSERTING A NEW 
SLIDE 

When you make powerpoint presentation, sometimes need arises to insert a 
slide between two slides to add some text, image or other multimedia 
components. To insert a new slide into a presentation, one of the following 
three ways may be used: 

1) Using the New Slide tab of Home Menu to insert slide 

2) Using shortcut key “CTRL+M” to insert a slide 

3) Clicking at space between two sides where new slide to be inserted and 
then by pressing Mouse Right-Button and click on new slide option to 
insert slide, you may insert a slide. 

Let us see how we may use these three options for inserting new slide in a 
presentation. 

Using the New Slide tab of Home Menu 

 

Fig.13.1:Inserting a  new Slide in a Presentation 
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In the figure 13.1, if you want to insert a slide between slide-2 and slide-3 
then click between slide-2 and slide-3 then, insert the new slide using any of 
the three options given above. 

 

Fig. 13.2: Inserting slide using Mouse right click 

13.3 SLIDE VIEWS 

Microsoft PowerPoint has the following views, which can be used at different 
point of time for different purpose during preparation, modification, slide 
presentation and printing: 

Normal View 

Slide Sorter View 

Notes Page View 

Slide Show View 

Slide Master View 

Handout Master 

Notes Master View 

 

Fig. 13.3: Slide Views 

While using PowerPoint Presentation, you can quickly switch between views 
by clicking on the view icons. 

Normal View: It is the main editing view, which is used to write and design 
a presentation.  Normal view displays slide thumbnails on the left, a large 
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window showing the current slide, in which you do the content insertion or 
editing. 

 

Fig. 13.4: Normal View 

Slide Sorter View: This view displays all the slides in your presentation in 
horizontal sequenced. This view helps in selecting your slides and readjusting 
their positions in your presentation. You can just click and drag your slides to 
a new location and make meaningful grouping of the slides in your 
presentation. In Slide Sorter View, you cannot edit the contents of a slide. 
You have to switch to Slide View, where you can edit the contents. 

 

 

Fig. 13.5: Slide Sorter View 

Notes Page View: The notes page is located below the slide window.  This 
allows you to write some points as notes on that specific slide. You can print 
your notes for reference or also you can give notes to the audience. You can 
also use notes while you are making presentation of your slides. 
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Fig. 13.6: Notes Page View 

Slide Master View: This view includes Slide, Handout, and Notes. 
Advantage of working in a master view is that you can make universal style 
changes to every slide, notes page, or handout associated with your 
presentation. When you want all your slides to contain the same fonts and 
images, you need to change those in one place (in the Slide Master) and the 
changes will be applied to all your slides.  

 

Fig. 13.7: Slide Master View 

You change and manage slide layouts in Slide Master View. Every theme has 
a several slide layouts. Some layouts are better for text and some are better 
for graphics. You have to choose the layouts which are suitable for your slide 
content. 

Handout Master View:  This view is used to manage presentation while 
printing. 
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Fig. 13.8: Handout Master View 

Handout Master View provides options for setting the followings (see figure 
13.9): 

Page Setup  

Handout Orientation 

Slide Orientation  

Slide Per Page  

 

Fig. 13.9: Handout Master View Options 

Slide Show View:  This view is used to show your presentation to the 
audience. This view displays one slide at a time in full-screen mode. You can 
start the slide show using F5 key (see figure 13.10).  
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Fig. 13.10: Slide Show View 

13.4 INSERTING A GRAPH AND DIAGRAMS 

Sometimes, we need to use graph and diagrams to make our presentation 
effective. Suppose, we need to prepare a PowerPoint presentation for 
demonstration of production trends of some products of a company in last 
five years in that case graphs and diagrams plays a vital role. In this situation, 
we are having multiple options to keep this information in our presentation. 
This information may be written in text, or presented in a table, but better 
way is to draw a graph and use it in presentation to make it more appealing.   

13.4.1  Insertion of a Graph/Chart 

Following is the process of inserting a graph in presentation: 

1) Open PowerPoint presentation, select the slide on which you want to 
insert the graph then go on Insert menu and click/press on Chart icon. 
Following Window will appear: 

 

Fig. 13.11:  Inserting Chart 
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2) Select a chart type you want to insert in your presentation. There are 
different chart templates available. These templates are column, line, pie, 
bar, area, XY (scatter), stock, surface, doughnut, bubble and radar. From 
these options, select the suitable template for your presentation.   

Let us select Line chart type. After selecting this one window with 
default data will appear. It is similar to Microsoft Excel sheet. In this 
sheet, you edit the information as per your need. As you can see in figure 
13.12, information is edited, columns represent years and rows represent 
different products. You need to save this data shown in figure 13.12 for 
future use. If you need to update the chart in future, this file will be 
required. Also this data will be required if you need to change the chart 
type.  

 

Fig. 13.12: Creating Chart 

As you make changes in your sheet as shown in figure 13.12, you will 
observe changes in chart on your presentation slide, as shown in figure 13.13.  

 

Fig. 13.13:  Insertion of chart in presentation 
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Once you have inserted the chart/graph, as per need, you can resize the chart 
on your presentation slide as shown in figure 13.14. 

 

Fig. 13.14: Resizing Chart 

If you need to change the chart type, you have to right click mouse button 
and click on change chart type and select the chart with which you want to 
replace this chart. If you select bar chart, you will get result as shown in 
figure 13.16. 

 

Fig. 13.15: Changing Chart Type 
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Changing chart of figure 13.13 to Bar Chart type: 

 

Fig. 13.16: Bar Chart 

13.4.2  Insertion of a Diagram 

In this section, we will discuss about how to insert diagrams in presentation 
slides. 

You can insert diagrams using Insert Menu. There you will get various 
options such as Picture, Clip Art, Photo Album, Smart Art and Shape. 

Either you can choose a diagram available in Photo Album or from Clip Art, 
or you can draw your own diagram using various shapes in Shape option. 

 

Fig. 13.17: Inserting Diagram 
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Fig. 13.18: Choosing Smart Graphics 

 

Fig. 13.19: Vertical Arrow List 

 

Fig. 13.20: Drawing Own Shape for Presentation 
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Check Your Progress A 

1) Explain how slides can be rearranged in a presentation using Slide Sorter 
View. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

2) A PowerPoint presentation is being prepared for demonstration 
performance of the students of B.Com (CBCS) Third Semester in course 
Basic Accounting. The marks of students are given in table below: 

Name of Student Marks in Basic 
Accounting 

Ravi 76 
Mohan 57 
Sarita 69 
Rohit 88 
Mohit 92 
Anita 56 

Insert these marks in the form of column chart in the presentation. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

3) Using following SmartArt Diagram, make a slide about sequence of 
steps required from registration to completion of IGNOU B.Com 
(CBCS) First Semester.  

 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 
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13.5  INSERTING PICTURE 

At time you are having pictures stored in your PC and you want to use it in 
your presentation. To insert picture in your presentation you can use: 

1) Insert Menu >> Select Picture Option >> Select Picture. 

2) It will take you to Picture folder and from there you may select the 
picture to be inserted in your presentation as shown in figure 13.21 

 

Fig. 13.21:  Inserting Picture in Presentation 

In case you need to draw your own picture and use in presentation. You can 
draw a picture using Paint tool. A picture drawing is shown in figure 13.22.  

 

Fig. 13.22: Drawing Picture 

Another way of inserting picture in your presentation is to copy the picture 
from a file/folder or from other source like Internet, Pen Drive, CD and paste 
it in your slide. Sometimes it is better to insert a Text Box in slide and then 
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copy the picture inside the Text Box. Also note that you should use only 
those pictures which are copyright free or permitted to use by giving 
acknowledgement to the source/owner. 

13.6 INSERTING SOUND 

A sound is an effective medium of communication. If situation arise to use 
some sound element in your presentation, you can do this by following: 

1) Select Insert Menu and  

2) Select Sound option 

 

Fig. 13.23: Inserting Sound 

Sound can be inserted using a sound file or using Clip Organizer or sound file 
stored in CD may be selected or you can record your own sound for some 
explanations. When you will insert a sound file it will be inserted and a sound 
Icon will appear on your slide. 

 

Fig. 13.24: Inserting Sound from a sound file 
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When you will insert a sound file you will be asked to choose one of the two 
options to start the sound play: 

1) Automatically  

2) When sound Icon is clicked 

 

Fig. 13.25:  Inserting Sound from Clip Organizer 

When you choose automatically, sound file will play automatically as soon as 
you reach to that slide in slide show view. If you have selected when clicked, 
the sound file will play only when you click on the sound Icon in slide show 
view. 

You can record your own sound in a specific slide in which you want to use 
it. For this, you have to select 

1) Insert Menu >> Sound Option >> Record Sound  

 

Fig. 13.26: Record Sound for Presentation 
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13.7 INSERTING VIDEO 

Video is a very powerful medium of communication. You may explain many 
processes or activities using a video of smaller size than using very large text. 

In PowerPoint Presentation, video components are commonly used to 
demonstrate activities and make presentation more effective. You can either 
insert video available in your computer in your presentations. You can create 
your own video using video recorder/camera or by even using your smart 
phone and use these videos in your presentation.  

To insert a video in PowerPoint presentation, you have to click insert menu 
and then select the movie option to select appropriate video file to be 
inserted.  

 

Fig. 13.27: Inserting Video 

13.8 SAVING PPT FILES IN EXTERNAL 
MEMORY& CLOUD 

When you make your presentation, you save it in a file. Sometimes, you need 
to copy these files in your USB Memory (known as Pen Drive) because 
always it is not possible to carry your laptop with you to make presentation. 
You can use following ways to copy/save PPT files in Pen Drive: 

1) If you are creating new presentation and you want to save it in Pen 
Drive. While saving the file, use Save As option and select Pen Drive to 
save the file. 
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Fig. 13.28: Saving PPT file using Save As option 

2) If file is already saved, let us say on your desktop and you want to copy 
in your Pen Drive. You can save that file in your Pen Drive by: 

Select the file using mouse. Right click the mouse button and select Send 
to option and select Pen Drive. This file will be copied to Pen Drive. 

 

Fig. 13.29: Copy file in Pen Drive 
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Saving PPT Files in Cloud 

1) Share a PowerPoint 2019 Presentation in the OneDrive 

Saving your files to the cloud lets you access them from wherever and makes 
it easy to share them with family and friends. To save documents online with 
OneDrive, sign in to Office. With a document open in an Office program, 
click File > Save As > OneDrive. If you haven't signed in, do that today by 
clicking Sign In. 

locations to which the presentation can be saved, as shown. ... 

Click the OneDrive location where you want to store your presentation. .. 

Navigate to another OneDrive folder or create a new OneDrive folder. ... 

Change the filename and then click Save 

 

Source: OneDrive 

Fig. 13.30: Copy file in OneDrive (Cloud) 

2) Convert a PowerPoint to Google Slides 

i) Open Google Drive. 
ii) Select "New" in the upper left-hand corner of the screen. 
iii) Select "Upload File." 
iv) Select the desired PowerPoint presentation. 
v) After uploading, right click and select "Open with," then select 

"Google Slides." 
vi) Select "File." 
vii) Select "Save as Google Slides." 
viii) Go to Google Drive. 
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Source: Google drive 

Fig. 13.31: Copy file in Google Drive (Cloud) 

Yes, your data is comparatively safer in the cloud as compared to in your 
own hard drive. In adding, files are easy to access and maintain. 
Nevertheless, cloud services ultimately put your data in the hands of other 
people. If you're not predominantly concerned about confidentiality, then no 
big shout 

Check Your Progress B 

1) You are preparing a presentation to teach use of computer in daily life. 
For this presentation, you required to insert pictures of different 
components of a computer system in slides. Explain the process you will 
follow to do this activity. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

2) Suppose you are having a diagram in your presentation and you want to 
insert an explanation for that diagram in your own voice. Explain how 
you will do it.  

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

3) You are having a presentation stored in your Pen Drive you need to do 
some modification in that presentation using your friend’s laptop and 
again copy the modified presentation in your Pen Drive. Explain the 
process of this activity. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 
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13.9 LET US SUM UP 

As multimedia components are very important tools for better 
communication. They are extensively used in PowerPoint presentation to 
make it more effective. PowerPoint is used for preparing range of 
presentations on various topics including educational presentation, business 
presentation, social awareness presentations etc. Microsoft PowerPoint has 
the different views, which can be used at different point of time for different 
purpose during preparation, modification, slide presentation and printing. 

To insert a new slide into a presentation one of the following three ways may 
be used: Using the New Slide tab of Home Menu to insert slide; Using 
shortcut key “CTRL+M” to insert a slide; Clicking at space between two 
sides where new slide to be inserted and then by pressing Mouse Right-
Button and click on new slide option to insert slide, you may insert a slide. 

To make a multimedia presentation attractive, effective and interesting 
multimedia component such as graphs, diagrams, charts, pictures, audios and 
videos can be added. Presentations can be copied and saved in the external 
memory and cloud. 

13.10 KEY WORDS 

PowerPoint: It is software from Microsoft which is used to create 
presentation. Generally, a presentation is created by logical collection of 
individual slides that contain information on a specific topic. PowerPoint is 
used for preparing range of presentations on various topics including 
educational presentation, business presentation, social awareness 
presentations etc. 

Normal View: It is the main editing view, which is used to write and design 
a presentation.  Normal view displays slide thumbnails on the left, a large 
window showing the current slide, in which you do the content insertion or 
editing. 

Slide Sorter View: This view displays all the slides in your presentation in 
horizontal sequenced. This view helps in selecting your slides and readjusting 
their positions in your presentation. 

Notes Page View: The notes page is located below the slide window.  This 
allows you to write some points as notes on that specific slide. 

Slide Master View: This view includes slide, handout and notes. Advantage 
of working in a master view is that you can make universal style changes to 
every slide, notes page, or handout associated with your presentation. When 
you want all your slides to contain the same fonts and images, you need to 
change those in one place (in the Slide Master) and the changes will be 
applied to all your slides.  
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Handout Master View:  This view is used to manage presentation while 
printing. 

Slide Show View:  This view is used to show your presentation to the 
audience. This view displays one slide at a time in full-screen mode. You can 
start the slide show using F5 key. 

13.11 TERMINAL QUESTIONS 

1) What is multimedia? How it can be used in a PowerPoint presentation to 
make it more effective? 

2) What is use of slide sorter view? 

3) How you can use a video created using your smart phone, in a 
PowerPoint presentation? 

4) Explain the process of creating a chart in PowerPoint with the help of an 
example. 

5) Explain how you record your own voice for explanation of a table used 
in a PowerPoint presentation. 

6)  Explain the procedure to upload files on a cloud using One Drive or 
Google Drive. 

 

Note: These questions are helpful to understand this unit. Do efforts for 
writing the answer of these questions but do not send your answer to 
university. It is only for yours practice. 
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14.1 INTRODUCTION  

Multimedia is anything and everything that you watch and listen in a form of 
text, photograph, audio, video and many other means which are omnipresent 
in a present scenario. This is typically recoded and played, displayed or 
accessed by information content processing devices such as computerized 
and electronic devices. We can use multimedia in every sphere be it business, 
schools, home, public places and virtual reality. Multimedia has animation, 
music, video and more of this. A multimedia presentation is a standalone 
presentation that includes information presented with slides, video, or digital 
representations and includes sound which might be a narrative, music or 
sound effects. Multimedia takes advantage of the brain's ability to make 
connections between verbal and visual representations of content, leading to 
a deeper understanding, which in turn supports the transfer of learning to 
other situations. In the present scenario, when technology is changing the 
world and bringing paradigm shift, the most used multimedia device on the 
planet is a smartphone. Multimedia offers lot of features like video, 
animation, text and audio while being interactive. There is a lot to consider in 
terms of what multimedia is and the proliferation of cell phones at different 
levels in different societies. A few more specialized ones would be TV’s, 
computers and game consoles. Further back, the iPod and perhaps many of 
the Personal Digital Assistant (PDA) could be added into the mix. It would 
be contingent on how severely you would need all the media types mixed to 
fall into the definition of multimedia. In this particular unit, we will be 
discussing the various applications and usage of multimedia in everyday life 
which includes entertainment, education, teaching, learning and many more. 

14.2 MEANING OF MULTIMEDIA  

To understand about multimedia, it will be better to firstly understand the 
term ‘Media’. Media is dedicated towards Broadcasting Video, Video 
Editing, News Forum, News Mediums (new papers, reporters) etc. Whole 
Multimedia consists of various mediums and media (Animation, Media, 
Video, Movies, Graphic Design and their tools).  

Multimedia is a combination of text, graphics, sound, animation, and video, 
interactive electronic or digital means of handling delivered to the user. 
Multimedia elements include the text, video, sound, graphics and animation. 
The advantage of learning about animation and multimedia is to promote 
work from home (WFH) culture so that most part of your life you don't need 
to be in stereotype job but groom your knowledge skill as a freelancer. One 
can earn from anywhere, even being from their home. And most of its jobs 
are related to films and music industries. 
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14.2.1 Advantages of Multimedia 
User friendly: It does not need the number of energy users, in this sense, 
one can sit down to watch the demo, one can read the text and hear the 
sound. It can be used for a diversity of audiences, ranging from one 
person to the entire group. 

Multi-Sensory: It uses the senses of many users, while the use of 
multimedia, such as hearings, sees and talk. It can be used for a 
variability of audiences, ranging from one person to the entire group. 

Comprehensive and Interactive: Through different media in the 
process of digital integration. The possibility of interaction easy 
feedback is greatly increased. It is also very flexible and can easily be 
changed to adapt to different situations and audiences. 

Deeper sympathetic: Multimedia learning takes the mileage of the 
brain's aptitude to make connections between verbal and visual 
representations of content, leading to a deeper thoughtful, which in turn 
supports the transfer of learning to other situations. All of this is 
important in today’s 21stcentury classrooms, as it prepares students for a 
future with higher-level thinking, problem solving and concerted skills. 

Improved problem solving: A large fraction of the human brain 
dedicates itself to visual processing. Thus, using images, video and 
animations alongside a text stimulates the brain. Student consideration 
and retention increase. Under these circumstances, in a multimedia 
learning environment, students can identify and solve problems more 
easily compared to the scenario where teaching is made possible only by 
textbooks. 

Access to a vast variety of information: With computers, tablets, 
smartphones and the internet, students are today better equipped than 
ever to search and find the information they need.  

14.3 USAGE AND MAKING MULTIMEDIA 

Multimedia is heavily used in the entertainment industry, especially to 
develop special effects in movies and animations (VFX, 3D animation, 3D 
printing, etc.). Multimedia games are a popular pass time and are easily 
available either as CD-ROMs or online. 

The various advantages of multimedia application in day to day life are given 
below: 

Multimedia applications allow the computer user to communicate with 
the computer system in a variety of ways either by speaking, writing or 
moving objects etc. 

It gives a real-world impression to the users while using a computer. 
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It enables communication with people in remote locations just like all 
sitting in a single drawing room. 

Users do not need to convert data into computer acceptable form rather 
the data can be easily acceptable in the form of voice, moving pictures, 
and images etc. 

It also enables disabled persons to use computer systems by connecting 
computers systems to other machines and electronic devices. 

There are two types of Multimedia elements which are omnipresent in the 
present scenario: 

Person to Person Communication: It provides a mechanism for user to 
interact with each other and a transport layer to move multimedia signal 
from one user to another. Multimedia signal is created by user interface 
and user is allowed to interact with via video calls, teleconferencing etc. 

Person to Machine Communication: It provides a mechanism for 
storage and retrieval of multimedia signal that are either requested by 
user or created by user. Examples include document archive and 
broadcast video, creation and access of business meeting notes etc. 

14.4 CHALLENGES FACED IN IMPLEMENTING 
MULTIMEDIA TOOL IN BUSINESS 

Companies generally face new challenges when they encounter with new 
technologies. Managers must overcome these if companies are to absorb new 
technologies efficiently. Similarly, presentation by using different multimedia 
tools for business will be a great way to represent the company virtually and in 
physical format. But prior to this, there are certain challenges which the 
companies must address which can really be helpful in enhancing a business. 
Few of such challenges are listed below such as: 

Information security (including data privacy, storage, and management) 

Social media 

Risk management and governance 

Regulatory compliance 

Technology integration and upgradation 

Resource management 

Infrastructure management etc. 

14.5 DOING DESIGNING USING GRAPHICS 

Graphic design is defined as “the art and practice of planning and projecting 
ideas and experiences with visual and textual content”. In other terms, 
graphic design communicates certain ideas or messages in a visual way. 
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These visuals can be as simple as a business logo, or as complex as page 
layouts on a website. Graphic design is useful all over the place. 
Graphic designers aren't limited to working in certain locations. A graphic 
designer works at magazines, advertising, marketing agencies, and more. 
They take graphical and textual elements and implement them into multiple 
types of media. Graphic design can also be used by companies to promote 
and sell products through advertising, or by websites to convey complicated 
information in a digestible way through info graphics, or by businesses to 
develop an identity through branding, among other things. These various 
graphic design elements include color, form, line, shape, size, space and 
texture. The elements are used in conjunction or opposition with each other 
to create visually striking and impactful designs. Examples of modern-day 
graphics are: 

Website design: It involves creating engaging and intuitive web pages 
for users. This includes overall layout, color scheme and navigation. 

User experience (UX) design: It is focused on ensuring a website or 
application is easy and satisfying to use. These designers emphasize 
value, usability, adoptability and desirability. 

Motion graphics designer animation: It brings visual elements to life 
through special effects, TV shows, video games and movies etc. 

14.6 ANIMATION 

Animation is the process of designing, drawing, making layouts and 
preparation of photographic sequences which are integrated in the multimedia 
and gaming products. It involves the exploitation and management of still 
images to generate the illusion of movement. A person who creates 
animations is called an animator.  An animator uses various computer 
technologies to capture the still images and then to animate these in desired 
sequence. Modern entertainment industry of these days i.e. film and 
television has gained popular heights because of advances in 
animation, graphics and multimedia. Television advertisements, cartoons 
serials, presentations and model designs all make frequent use of animation 
and multimedia techniques. Among the many popular forms of animation, the 
three most prominent are discussed below: 

1) 2D Classical Hand-Drawn Animation: 2D Classical hand drawn 
Animation is the oldest and simplest yet not easiest and cheapest method 
of animation. Even with the advancement of technology the principle of 
drawing remains the same for it, pencils are traded in for stylus’ and 
paper exchanged for cintiq’s and Wacom tablets. These technical tools 
are making it easier and more accessible; some of the greatest animators 
alive still employ pencil and paper to draw their animation.   
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2) 3D Computer Graphics Animation: This form of animation only 
became possible with innovations in computer graphics in the 1990s, and 
has become massively popular since then. The computer graphics allow 
the animator to create photo realistic images that the classical animation 
can’t. Also, powerful animation software allows for in-betweens, 
lighting, building crowds, environments and more. Because of this, it has 
become the most common form of animation used in the film industry 
today. 

3) Stop-Motion Animation: Stop motion animation is the oldest as well as 
one of the most interesting forms of animation. This form involves 
taking individual photographs of physical models, objects, puppets or 
people as they are moved around in one frame at a time. 

14.7 MAKING PRESENTATION USING 
GRAPHICS 

Presentations can be made more interesting and catchier by using graphics. 
A good and pleasant graphics presentation is something that is aesthetically 
pleasing and consistent enough not to distract the attention of audience from 
the subject and the author, and significant enough to be an ideal addition to 
the words which are spoken. Graphics presentations are considered more 
popular than the simple presentation. There are certain benefits that graphics 
provides over simple text. Graphics are particularly good at communicating 
that one thing is larger than another, while illustrating relative amounts and 
can also easily break complicated concepts into multiple graphics for easy 
understanding. 

14.8 MAKING PRESENTATION USING 
MULTIMEDIA 

Humans are visual creatures, and as such we prefer a visual illustration. A 
multimedia presentation differs from a normal presentation in sense that it 
contains some form of animation or media. Multimedia presentations have 
become an inevitable part of business and education now a days. With the 
rising demand for powerful and feature-rich presentation software, 
developers keep presenting more and more advanced tools that actually make 
users create impressive presentations faster and more easily than ever. 
A multimedia presentation is a standalone presentation that includes 
information presented with slides, video, or digital representations and 
includes sound which might be a narrative, music or sound effects.  Except 
for the lack of touch and smell, it is virtually similar to face-to-face 
communication, especially when presented in a high-resolution life size 
screen. Typically, a multimedia presentation contains at least one of the 
following elements: 
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1) Video or movie clip 

2) Animation 

3) Sound (this could be a voice-over, background music or sound clips) 

4) Navigation structure 

Choice of Multimedia Presentation Technology: 

The first and hardest part for the presentation is to choose the technology. 
The choice comes down to two main contenders, Adobe Flash or Microsoft 
PowerPoint. A brief on both the Adobe Flash and Microsoft PowerPoint is 
given below: 

Adobe Flash: Adobe Flash has a very good video compression technology; it 
allows to create presentations with powerful animation. The best part of Flash 
is that it also allows to put presentations directly onto their website. 

Microsoft PowerPoint: The easiest way to create a multimedia presentation 
is in Microsoft PowerPoint. In MS PowerPoint presentation, we can add 
video, a soundtrack and also a reasonable degree of animation as per our 
requirements. By far the biggest advantage of making multimedia 
presentations in PowerPoint is that it is easy for anyone to be able to edit the 
presentation. 

14.9 MAKING PRESENTATION USING 
ANIMATION 

Presentations can be made catchy by using animation effects. Use of 
animation in a presentation complement the content and draw the user’s eye 
to key elements.  There is no need to use any separate app to create animation 
effects in a presentation.  PowerPoint offers some of the easiest, point and 
click tools to do this. While adding animation to the presentation instead of 
the effect the content of the presentation must be the focus point. There are 
two key types of animation in Microsoft PowerPoint which can be used to 
add the animation effect in the presentation: 

Object animations includes individual items like, text or shapes going in 
motion on a slide. 

Animated transitions include the effects that play when you move from 
one slide to the next in PowerPoint. 
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Check Your Progress A 

1) What are the types of Multimedia elements? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

2) What are the various challenges faced in implementing multimedia tool 
in business? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

3) What are the various popular forms of animation? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

4) How to make presentations by using Graphics? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

14.10 YOUTUBE 

YouTube is a website designed for sharing video. Millions of users around 
the world have created accounts on the site that allows them to upload videos 
which can be watched by anyone. Every minute of every day a large number 
of videos are uploaded on YouTube.  

 

Source: YouTube  

Fig. 14.1: About YouTube 
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Video files can be very large and are often too big to send to someone else by 
email. By posting a video on YouTube, you can share a video simply by 
sending the other person a URL link that is, the address of the relevant 
internet page. When YouTube was created back in 2005, it was intended for 
people to post and share original video content but since then it has also 
become both an archive for storing favorite clips, songs, jokes, as well as a 
marketing site for companies to promote their products. 

Main Functions of YouTube: 

1) Users can search for and watch videos of their interest 

2) A personal YouTube channel can be created to reach to a large group of 
people 

3) Upload videos to your channel 

4) Video uploaded on YouTube can be watched and shared  with others free 
of cost 

5) Users can subscribe and follow other YouTube channels and users to get 
updated with any further notification by them 

6) Various playlists can be created as per the need to organize and group 
videos together 

14.11 APPLICATION OF YOUTUBE IN BUSINESS 

Any kind of business be it small or large must continually think of ways to 
get its products in front of as many people as possible. YouTube can help the 
business to grow in a cost effective way if it is actively used as a part of its 
marketing strategies. Some of the applications of YouTube in business are 
explained below: 

1) Using YouTube for Brand Awareness: Many advertisers often use 
YouTube for advertising their brands to create awareness. Here it's not 
about individual videos or services, rather it's a chain effort to promote 
the brand in the same way that is seen on television. Single videos might 
get lost in the heaps of videos but the brand videos don't. Brand 
awareness videos are more about entertaining which is a simple approach 
where the brand makes an image for its viewers to enjoy. 

2) Using YouTube for Advertising Products: YouTube can be used for 
advertising about the products. For the category that pushes individual 
products, YouTube would be the best place as this requires direct 
approach that makes videos informative plus educational while focusing 
on brand and entertaining. 

3) Using YouTube for Retail Promotion: Many brands use YouTube to 
promote retail stores. In this case the videos produced can be in general 
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or specifically targeted or for short-term promotions. Even educational 
institutions can pitch in for YouTube videos by demonstrating products 
like Google Classroom, Microsoft Teams, Teach Next or other such 
services that they offer. 

4) Using YouTube for Sales: Using YouTube for generating sales for 
products/services is a terrific idea and can be implemented at the 
grassroots level itself. All need to be done is to show the product in 
action or provide a clip of the service related to the question and generate 
sales by directing the viewer to the website. The best idea is to showcase 
the product video, how to use, upgrading and other such stuff. Create a 
shorter version of the videos which can be promoted by using YouTube 
Ads, but focus on the goals of the product in the video which the user 
wants to see and it'll gain more YouTube viewership. 

5) Using YouTube for Product/Customer Support: Many companies 
show themselves as extending support, which is not true; only some 
companies extend their support for existing & upcoming customers. In 
this case, YouTube helps in generating new focus for businesses in 
support sectors. Focus can be made to the customer problems, Q&A, and 
videos can be produced to address these issues and methods.  It will not 
only help the customers but it will also help the marketers in future. 
Useful service- related videos will always reduce the company's costs. 

6) Using YouTube for Training Purpose: YouTube videos can also be 
used for internal and external purposes like product training for 
meetings, conferences, etc. Doing so will save a lot of time. Recently 
digital marketing companies like MOZ, Distilled, and Blue Glass use 
these methods to reach consumers for conferences. Apart from these, 
people who are unable to attend conferences due to various reasons can 
purchase these informative videos online from the relevant stores. Using 
these informative videos in YouTube is gaining popularity, as now the 
videos are available for rental purpose where the user can watch them as 
and when required. 

14.12 UPLOADING A VIDEO THROUGH 
YOUTUBE 

Videos on YouTube can be uploaded in 4 easier steps as given below: 

Step 1:  Sign in to your account: First step is to upload a video on YouTube 
by sign in to the account. Videos cannot be uploaded until the users 
have signed in the account. For signing in go to the YouTube 
homepage and click the sign-in link in the top right-hand corner. If 
you have multiple accounts associated with the device you are using 
you will be prompted to choose the appropriate one. Once done so, 
enter your password and it will take you back to the main YouTube 
page. 
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Step 2:  Click the upload button: After signing in the first step, user needs 
to click the upload button. It’s also located in the top right-hand 
corner and is represented by an up arrow with a line underneath it. 
That will take you through to a dedicated upload page, where you 
can choose where you have to source your upcoming viral sensation 
from. 

Step 3:  Choose video source and privacy settings: The upload page gives 
you a few different options to pick from and they are all worth 
considering. For starters, you need to decide whom you want to see 
your video, and adjust the privacy settings accordingly. If you want 
anyone and everyone to see it, choosing the “Public” setting in the 
central drop-down is the way to go. If you want a little more control 
over who sees it, selecting “Unlisted” keeps it from being findable 
through searches. Instead, people would need to click the direct link 
or go to your channel. If you are just looking to keep the video 
privately for yourself, or to store something for later unveiling, 
choose to make your video “Private” instead. “Scheduled,” lets you 
choose a future time and date for a video to become public. Once 
you have made your decision about who can see your video, you 
need to select where you are uploading it from. There are specific 
options on the right-hand side for live-streaming and importing, but 
most will be doing so from their local device. For that, click the 
large white arrow with a gray backdrop in the center of the screen 
and pick the video you want to upload from your various files and 
folders. 

Step 4: Managing the upload:Once the videos being uploaded have been 
confirmed by the user, they will be taken to the upload page. Here, 
the users will be able to see a progress bar at the top of the screen, 
which will show how much of it has uploaded, and how long until 
it’s completed. 

 

Source: YouTube 

Fig. 14.2: Uploading videos on YouTube 
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14.13 EARNING ADVERTISEMENT REVENUE 
FROM YOUTUBE 

Earning with YouTube is easy, but making big money with the platform can 
be a challenge. Below stated are few ways to earn revenue from YouTube: 

Enable AdSense for YouTube on Your Account: The first two steps in 
earning online revenue with YouTube is to open an account and turn on 
account monetization. Enabling monetization requires accepting YouTube’s 
advertising guidelines and connecting to an AdSense account for payment. 
Enabling ads to YouTube videos requires agreeing to Google’s ad revenue 
share for YouTube. There is a 45/55 split for all content creators, so Google 
keeps 45 percent of all YouTube advertising on videos, and the users get the 
remaining 55 percent. 

Upload a Video and Promote: In order to earn revenue on a video, one 
needs to first post videos on one’s YouTube account. Once the video is 
online, people needs to watch it. For promoting the content, the users should 
share it to his social networks, to family and friends, on blogs, and any other 
possible digital outlet. More views to the videos mean more money in pocket.  

14.14 GOOGLE ADSENSE 

There are many ways to monetize the website traffic, and most of them are 
related to advertising third-party products or services to website visitors. 
There are many advertising programs that can help to earn money now a 
days, but the most popular is Google AdSense. This advertising program was 
launched in mid 2003 by Google and is currently the most popular 
advertising program on the Internet. It provides a good opportunity for 
webmasters and site owners to monetize their traffic. Once the AdSense 
account is linked to users YouTube account, they start receiving credit for 
each video’s monthly revenue. Once $100 are accumulated in earnings, 
Google will issue a payment to the registered users bank account. The user 
can choose to be paid either via direct deposit (not available in all countries) 
or by cheque, out of both the options direct deposit is the fastest method and 
has no fee. 

The Advantages of Google AdSense: 

1) A huge number of publishers and advertisers:  As of today, over 10 
million websites are using it. 

2) High level of security, safety and transparency for both advertisers 
and publishers: This is another good feature of AdSense. Google acts as 
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an intermediary between the two sides and is mindful of the whole 
process being transparent and clear for everyone. All the necessary 
metrics can be tracked within Google Analytics Account. 

3) Variety of ad formats: In AdSense, advertisers can run text, images, 
HTML ads, video ads and much more, and in many different sizes. A 
publisher can experiment with different ad types and figure out which 
ones drive the most revenue. 

14.15 CREATING A YOUTUBE PERSONAL 
CHANNEL 

Anyone can view YouTube without having an account. Nevertheless, you 
need to generate a YouTube channel (it's free) if your idea to upload videos, 
add comments, or make playlists. Review the information that's displayed, 
including your account name and image, and authorize the information is 
correct to make your channel 

 

Source: YouTube 

14.3: Creating A YouTube Personal Channel 

1) Start with the basics: Creating a business channel is incredibly easy. It 
can be created by just few click by following the given steps: 

Sign into YouTube and click on the user icon at the top right of the 
screen 

Click on the gear icon to get to your account’s YouTube Settings 

Click on Create a new channel 

Then choose “Use a business or other name” 

Add your Brand name and click create  

2) Fill in the about section: After doing the basics, the next step is to fill 
out profile and channel description. Here one needs to describe the brand 
upto what viewers expect to see on the channel. This is also a great place 
to add links to the website and other social media networks. This 
description will appear in more than one place on channel. 
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3) Channel your art: When you go to a YouTube channel, you will 
immediately be greeted with a large banner displaying the channel name. 
This is your cover photo and is prime real estate for introducing your 
brand. You can make your cover photo as extravagant or minimal as you 
like, but just make sure that brand is the focal point, as it is going to be 
the first impression someone gets upon entering.  

4) Know the market and content type: While starting a YouTube 
channel, the user must have more than enough source material to work 
with, and he/ she should be able to can approach the content in more than 
one way. User should also create content that is aimed at the target 
demographic of the business. The more that you cater to your target 
market, the more likely they will want to look into your business 
services. 

5) Upload first official video: After a fair editing and filming of video is 
done it’s the time to upload it. Video can be uploaded by clicking on the 
upload option at the top right of the screen while logging into the 
account. 

6) Optimize for search: YouTube has its own set of parameters to 
optimize your video for search. While uploading a video, user will be 
asked to fill in a title, description, and tags etc. These are essential 
components for the video be easily discoverable in YouTube search.  Fill 
these sections out to the best of your ability using keywords to describe 
the video and your business. If the video is well optimized for YouTube 
itself, this can extend to search engines as well.  

7) Stay consistent: Creating a successful YouTube channel takes time and 
effort, and viewers expect consistency from the channels that they 
subscribe to. After the first video, one must be sure to plan the next few 
videos ahead of time and then finally to promote your channel Integrate 
it in the website and share videos outside of YouTube. 

14.16 SUBSCRIBE FOLLOW YOUTUBE 
CHANNEL 

Users can subscribe the channels they want to see more content and get 
updated with the latest news from those channels. The particular channel can 
be subscribed by clicking a Subscribe button under any YouTube video or on 
a channel's page. Various step given below should be followed for 
subscribing a YouTube channel: 

Steps to Subscribe/Follow a YouTube channel: 

1) Open the YouTube app or go to m.YouTube.com. 
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2) Sign in to YouTube. 

3) If you're on the Home tab: 

Below the video whose channel you want to subscribe to, tap the 
channel icon. 

Tap Subscribe. 

4) If you're watching a video whose channel you want to subscribe to: 

Below the video, tap Subscribe. 

Once you subscribe to a channel, you will see a list of recommended 
channels on your screen. These are based on related channels that you are not 
already subscribed to. You can always view a channel’s content before 
subscribing. You can opt to get a notification every time the channel 
publishes content by changing your notification settings. To unsubscribe 
from a channel, follow the same instructions for subscribing to a channel. 
Instead of tapping Subscribe, tap Subscribed. A notification confirming that 
you have unsubscribed from the channel will appear at the bottom of your 
screen. 

14.17 UPLOADING VIDEOS ON CHANNEL 

Using YouTube or another free video-sharing site is the easiest way to put a 
video on the website. Most of these sites offer free accounts and let the users 
upload an unlimited number of videos. YouTube generates a code to use to 
embed your video on your website or blog. 

 
Source: YouTube 

Fig 14.4: Uploading Videos on YouTube 
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Content Delivery Network (CDN) can also be used for a website video. It 
uploads, convert, host, and stream your website videos, plus a lot more 
beyond that. You can customize the look and behavior of the video player, 
automatically insert ads into your web videos, or charge users to download 
your video content. 

14.18 CREATE PLAYLIST TO ORGANIZE 
VIDEOS  

A playlist is a group of videos created by you or someone else on YouTube. 
Whether you are a YouTube viewer or creator, it’s a way to organize videos 
with similar characteristics. If you have created any music playlists in the 
past, it’s a concept you will be familiar with. In a nutshell, playlists make it 
easy for viewers to find the videos they want to watch with a few simple 
clicks, videos are saved and sorted. 

 
Source: YouTube 

Fig. 14.5: Organizing YouTube Playlist 

Most people are familiar with the concept of music playlists by now, but not 
many realize you can also make video playlists either private or shareable. 
With YouTube, making playlists is a flexible way to group favorite videos. 

How to Add Videos to a Playlist: 

Adding videos to a YouTube playlist is simple. Underneath every video is 
an Add to the icon (appears as a plus symbol). If you have already created 
any playlists, they are listed in the drop-down menu, along with a Watch 
Later option and a Create new playlist option. If you select Create a new 
playlist, you are asked to enter a name for the playlist and to select a privacy 
setting. The privacy settings are: 

Public – anyone can search for and view your playlists 

Unlisted – only people you send a link to can view the playlist  

Private – only you can see the playlist 
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How to organize Your YouTube Playlists: 

Existing playlists can be managed and edited from the menu pane at the left 
side of the YouTube screen. If you don't see it, click the three-horizontal-line 
menu icon at the top left corner to expand the pane. The Library section 
contains your Watch Later list and each playlist that you've created. Click on 
a playlist name to see information about the playlist including a list of each 
video you've added to it. You can remove videos from the playlist, select 
a Shuffle Play option, and select a thumbnail image for the playlist. 

How to optimize YouTube Playlists for Search: 

YouTube allows users to add titles, tags, and descriptions to their playlists, 
just as individual videos. Adding this information makes it easier for people 
to find any playlists when they do a web search and makes it more likely that 
YouTube recommends playlist to people watching similar videos. Just click 
on a playlist in the left pane and select Edit when the playlist information 
screen opens. Click Add a description and enter titles, tags, and descriptions 
in the box provided for that purpose. In this screen, the users can also reorder 
the videos in the playlist and change the privacy settings. 

14.19 FUTURE OF ANIMATION WITH 
ARTIFICIAL INTELLIGENCE 

The arena of multimedia covers a broad range of research and technologies 
that intent to progress solutions for individual disciplines as well as 
multidisciplinary domains. From the beginning, multimedia research has 
employed Artificial Intelligence (AI) techniques to address various 
encounters in this zone. 

A great personality that comes to our mind when we discuss about animation 
is 'Walt Disney'. They are identical with mainstreaming of animation. He was 
a true visionary, as he could predict what lies in the future, much ahead of his 
times. His aptitude and thoughts twisted easy 2-D characters supported a 
mouse and a duck into a multi-billion-dollar business multinational. 

Multimedia plays an energetic character in the smarter cities eco-system due 
to enormous occurrence of multi model sensors and smart objects in the 
atmosphere, increased multimedia teamwork among dissimilar organizations, 
and real-time media sharing between socially connected people. 

Traditional animation (or classical animation, cell animation, and hand-drawn 
animation) is an animation procedure in which each frame is drawn by hand. 
The method was the leading form of animation in cinema until the advent of 
computer animation. 21st Century, 3D characters are not any lengthier a mix 
of triangles and polygons etc., but, realistic characters that are frequently 
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created with such carefulness that an automatic express may not even be 
adequate to distinguish between real and energetic. 

Types of 3D Animation 

3D Video and Film.  

Among the types of 3D animation, 3D video and film are the most common.  

Interactive 3D.  

This is a 3D animation production that features purely digital realm and 
created using a 3D computer software. 

Virtual Reality 3D  

Inverse Kinematics  

Fluid Simulation  

3D Skeletal Animation 

Animation with AI 

AI In Animation 

The world was familiarized to 3D animation via The Graphics Group. 21st-
century 3D characters are no lengthier a mixture of triangles and polygons 
etc. Machines are no longer just learning, but, imagining as well. Current 
years have observed the immediate progress of deep learning and AI chiefly 
built tools that are reaching to enlarge the contemporary possibility of 
animation to invisible levels. 

Features of AI in animation 

Automation and artificial intelligence (AI) are transforming businesses and 
will underwrite to economic growth via contributions to productivity. In 
Animation and multimedia, it has created a wonder. 

AI automation with train deep learning algorithms to accomplish routine 
tasks like creating a digital character look lifelike. 

AI facilitates fast formation of varied game elements like 3D models and 
animations, game pure mathematics, story integration and texturing 

AI tools, and robots can begin dominating the industry, simply the 
approach they took over the factories and therefore the client service 
duties 

Inventive artists to devote fewer time on the labor-intensive setting by 
frame redaction method and to target additional fascinating things. 

Norah AI software came with Auto Rig tool, human motion simulation 
and blending as well as a Motion Editor that can grip a wide range of 3D 
animation and game design requirements. 
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Source: 

Fig. 14.6: Multi-function virtual assistants 

The above figure may include multi-function virtual assistants, which 
connect to mini-applications that use semantic search to inform, endorse, or 
manage on behalf of users 

Artificial intelligence holds the significant impact to a new epoch of 
innovation, one where computers begin to work logically on our behalf rather 
than under our knowledge. It’s an age where know-how will become more 
instinctive, more informal, brainier, will permit businesses to improved know 
and assist their customers in ways beforehand incredible, and eventually 
resolve some of the earth’s principal contests. 

Check Your Progress B 

1) How to use YouTube for retail promotion? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

2) What are the advantages of Google AdSense? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 
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3) How to add videos to playlists? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

4) What are the ways to earn advertisement revenue from YouTube? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

14.20 LET US SUM UP 

Multimedia plays an important role in today's society because it is society 
now all are the things is kept up with the times. The multimedia is a good 
way for communication because that can easy to communicate and 
understand what they say. After that, multimedia has animation, music, video 
and more of this. A multimedia presentation is a standalone presentation that 
includes information presented with slides, video, or digital representations 
and includes sound which might be a narrative, music or sound effects.  

Animation involves the exploitation and management of still images to 
generate the illusion of movement. A person who creates animations is called 
animator. He / she use various computer technologies to capture the still 
images and then to animate these in desired sequence. Animations in 
PowerPoint can really draw your audience's attention to elements of a 
presentation. You don't have to use separate apps to create animation effects. 
PowerPoint offers some of the easiest, point and click tools to add animation 
to your presentations 

YouTube is a website designed for sharing video. Millions of users around 
the world have created accounts on the site that allow them to upload videos 
that anyone can watch. Every minute of every day, more than 35 hours of 
video is uploaded to YouTube. For uploading a video one can Sign into your 
account, Click the upload button, choose video source and privacy settings 
and Managing the upload. 
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There are many ways to monetize your website traffic, and most of them are 
related to advertising third-party products or services to your website visitors. 
There are many advertising programs that can help you earn money 
nowadays, but the most popular is Google AdSense. This advertising 
program was launched in mid-2003 by Google and is currently the most 
popular advertising program on the Internet. It provides a good opportunity 
for webmasters and site owners to monetize their traffic - every year, Google 
pays over $10 billion to its publishers. 

AI is automating animation tasks exclusively in order that the animators 
don’t get to lure frame by frame. The AI-based advanced algorithms are 
proficient of automating the rendering of advanced visual effects. 

14.21 KEY WORDS 

Multimedia: Multimedia is a combination of text, graphics, sound, 
animation, and video, interactive electronic or digital means of manipulation 
delivered to the user. 

Multimedia Presentation: Multimedia Presentation is a standalone 
presentation that includes information presented with slides, video, or digital 
representations and includes sound which might be a narrative, music or 
sound effects. 

Animation: It is the process of designing, drawing, making layouts and 
preparation of photographic sequences which are integrated in the multimedia 
and gaming products. 

YouTube: YouTube is a free to use service and a can be a great space for 
teens to discover things they like. For many young people, YouTube is used 
to watch music videos, comedy shows, how to guides, recipes, hacks and 
more 

Google AdSense: Google AdSense provides a way for publishers to earn 
money from their online content. AdSense works by matching ads to your 
site based on your content and visitors. The ads are created and paid for by 
advertisers who want to promote their products. 

YouTube playlist: A playlist is a group of videos created by you or someone 
else on YouTube. Whether you are a YouTube viewer or creator, it’s a way 
to organize videos with similar characteristics. 

14.22 TERMINAL QUESTIONS 

1) What is multimedia? What are the advantages of learning multimedia? 

2) What are the challenges faced in implementing multimedia tools in 
business? 

3) What are the various forms of animation? 
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4) How is YouTube useful for businesses? 

5) How can one upload a video through YouTube? 

6) How can advertisement revenue can be earned from YouTube? 

7) What is Google AdSense? And what are its various advantages? 

8) How can someone create a YouTube Personal Channel? 

9) What are the steps to subscribe/follow a channel? 

10) What is a YouTube playlist? How to organize a YouTube Playlist? 

 

Note: These questions are helpful to understand this unit. Do efforts for 
writing the answer of these questions but do not send your answer to 
university. It is only for yours practice. 
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15.2 MAKING PRESENTATION WITH 
FEATURES OF POWERPOINT 

When we are asked to speak on some topic for ten to fifteen minutes, the first 
thing comes in our mind is what to speak and what not to speak. This is the 
point from where preparation of presentation starts. We may start thinking 
that what kind of components will be used in the presentation. Whether 
presentation will be in simple text or images, graph, tables will be used for 
making effective. Also, we explore the requirements of audios and videos for 
making presentation effective. One of the important points to note is that, 
while planning for making a presentation it is better to have knowledge on 
topic.  If you do not have proper knowledge of the topic, it is very difficult 
for you to make presentation on that topic. Knowledge of the topic will help 
you in identifying different components for making presentation. When you 
plan to make presentation, first thing you have to make sure that what the 
available resources to be used in presentation.  For example, if you have to 
make a power point presentation for showing performance of students of 
your batch in various courses in final examination then you need to have all 
the relevant information pertaining to this topic. This problem is simple for 
you, because you are aware about the problem as you know what the courses 
are in your current semester. How many students are there in your batch, also 
specific details about each student available in your batch? Also, you are 
aware about evaluation criteria and passing requirements of various courses. 
Hence making presentation this topic should not be difficult for you. 

Once you are having knowledge of topic, you need to focus on features of 
PowerPoint may be used in making of your presentation. Some of the 
important points are given below which you need to consider and identify the 
suitable points and components useful for making of your presentation. 
Subsequently we will briefly discuss about these points: 

1) Choose between a blank presentation and a template: When you start 
a new PowerPoint file, you can either create a blank presentation or a 
template. Blank presentations allow you to apply your own style, but this 
can be a time-consuming process. Templates can give your presentation 
a uniform style. You can access templates from the File tab. Click New 
and then browse the available templates.  
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Fig. 15.1: Blank Slide 

2) Title of Presentation: When you make presentation the very first thing 
you have to decide is the title of presentation. Your title is the first thing 
that your audience will see. It should be easy to read and give a basic 
overview about the topic of the presentation. First slide should be used to 
keep title of presentation, name of presenter and affiliation (organization 
to which presenter is associated) of the presenter. You should keep font 
size of title appropriately and it should be large enough to be easily 
visible. Similarly, color of the text also should be appropriately chosen in 
such a way that it is soothing to eyes and readable. 

 

Fig. 15.2: Title Slide 

3) Add new slides for content: Press Ctrl + M for a new slide. A blank 
slide will be added after the slide you are currently on. The slide will 
contain a title box and a text box. You can choose to use these or insert 
your own objects using the Insert tab. When adding a text box, you can 
click and drag to make it whatever size you'd like. You can then adjust 
this later by grabbing one of the corners with your cursor and then 
clicking and dragging again. You can click on any text box and start 
typing to begin adding text to your presentation.  



Creating Business 
Presentation

51

 

Fig. 15.3: New Slide 

4) Add contents of presentation: Second slide should have contents to be 
covered in presentation. While writing contents proper numbering should 
be done for the topics and sub-topics. Also, you may use bullets 
wherever you feel appropriate.  

 

Fig. 15.4: Add content to the presentation 

5) Format the slide's text: The text of the presentation can be changed as 
per the requirements for this by following steps: 

Select the text that you want to change 

Click the Home tab and review your text formatting options in the 
"Font" section of the toolbar. 

To change the font of the selected text, click on the current font's 
name and then click on your preferred font. 

To change the size of the text, click the numbered drop-down box and 
then click a larger or smaller number based on whether you want to 
enlarge or shrink the text. 
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Fig. 15.5: Text Formatting 

When we make presentation, font size should be used appropriately for 
different purposes. For example, headings and sub heading should have 
larger font size compare to the contents on the slide. Similarly, if you 
have tables and images on your slide, use appropriate font size for their 
levels. For example, if you are making a presentation for business 
meeting discussion among 10-15 people, the size of the font may be 
relatively small. When your presentation will be used for delivering a 
lecture in front of large number of audiences may be more than 50 or 
even more than that. You have to keep font size in such a way that your 
presentation content is visible to the last person in the audience. You can 
also change the color, bolding, italicization, underlining, and so on from 
here. 

6) Add transitions between slides: Once you have some content in your 
slides, you can start adding some effects to help make it a bit more 
interesting for your audience. Transitions can be added to the slides by 
following steps given below: 

Select a slide and click the Transitions tab a list of the most common 
transitions as shown in the figure will appear.  

When you pick a transition, it will affect how that slide appears. 

You will be able to see a preview in the slide editing window when 
you click each transition. 
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Fig. 15.6: Add Transitions 

7) Add Shapes/ Smart Arts/Chart: Various shapes, models, graphs and 
charts can be added in the presentation as per the requirement. Charts 
button are used to insert easy-to-read charts that will help the audience 
understand your data. Once you choose your Chart type, Excel will open, 
allowing you to enter in your data or copy it from an existing 
spreadsheet. Whereas, shapes button are to insert pre-made shapes or 
dray your own. You can use the shapes to outline important text or create 
arrows and other visual indicators. To add shapes or charts do the 
following: 

Click on the insert of the toolbar, and in that go to the illustration. 

In illustration select from the available shapes, smart art,  3D models, 
charts of your choice. 

 

Fig. 15.7: Add Shapes/ Smart Art/ Chart 
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8) Add images: We can add pictures, diagrams, and other visual aids in the 
presentations, these help the audience to grasp the ideas quickly. Images 
break up the monotony of text and help keep the audience from tuning 
out. To add images in the presentation, follow the steps given below:  

Click the Insert tab, and go to images option, here given a large 
number of options when it comes to inserting objects. 

Click the picture button to insert a picture from a file on your 
computer.  

You can click the photo album button to insert an entire album of 
photos into the slide as well. 

 

Fig. 15.8: Add Image 

9) Add backgrounds: Plain white is boring; to make the presentation more 
lively and innovative backgrounds can be added to it. Adding an 
appropriate background gives visual flair to the presentation. Follow to 
step given below to add the background: 

Right-click on a blank section of your slide and select "Format 
Background",  

or 

Click the Design tab and the click the arrow icon next to 
"Background" on the far right. 

Choose your fill type. You can choose a solid color, a gradient fill, a 
picture background, or a pattern fill. Selecting each choice will 
display several options for it, such as fill color, picture location, 
gradient settings, and more.  

By default, the background will only be applied to your active slide. 
Click the "Apply to All" button to apply your background choices to 
every slide.  
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Fig. 15.9: Add Background 

10) Add PowerPoint animations: PowerPoint has an incredibly robust 
animations engine designed to power your creativity. Animations are 
movements that you can apply to individual objects on your slide. You 
can add animations to multiple objects at one time by selecting them all 
first and then applying the animation to them. To add a PowerPoint 
animation to an element of your slide, simply: 

Select the element 

Go to the Animations tab in the Ribbon 

Click on the drop-down arrow to view your options 

Select the animation you want 

 

Fig. 15.10: Add Animations 
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There are three ways to preview a PowerPoint animation: 

Click on the Preview button in the Animations tab 

Click on the little star next to the slide 

Play the slide in Slide Show Mode 

11) Add links: You can add links to your slides that will allow you to 
quickly access websites or email addresses. To add a link,  

Place the cursor in a text box and then right click 

A dialogue box will appear, then select Hyperlink option, while 
clicking on hyperlink a box as shown in the figure will appear, select 
the object you want to link and click “ok”. 

You can choose to link to a file on your computer, a webpage, an 
email address, or even another slide in your presentation. 

 

Fig. 15.11: Add links 

12) Add speaker notes: Slides are best when you don’t cram in too much 
information. You can put helpful facts and notes in the speaker notes, 
and refer to them as you present. To open the notes pane, at the bottom 
of the window,  

Click notes button in PowerPoint given below. 

Click inside the Notes pane below the slide, and begin typing your 
notes. 
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Fig. 15.12: Add speaker notes 

13) Add video: You can add video files to your slides. This can be useful for 
reports or any other video file that may relate to your presentation. The 
video file will play when the slide appears. 

Click the Video button in the Insert tab. 

You will be able to select between online videos and videos on PC 
as per the requirement select your choice and add video to the 
presentation. 

 

Fig. 15.13: Add Video 

14) Navigate your presentation: You can use the frame on the left side of 
the window to quickly scroll through your slides. Clicking any of them 
will open that slide so that you can edit it. You can click the Outline tab 
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to see an outline tree of your presentation. Each slide will be labeled by 
the slide title. 

 

Fig. 15.14: Navigate Presentation 

15) Preview your presentation: You can get a basic feel for the flow of 
your presentation at this point by pressing F5 to start the slide show. 
Click the mouse to advance the slides. Use the preview slide show to get 
an idea of how long the presentation is and how well information flows 
from one slide to the next. 

15.3 MAKING BUSINESS PRESENTATION 

Business presentation is defined as any formal information about the 
business, products or practices to inform, educate, motivate and persuade 
internal and external audiences.  These presentations are usually carried out 
via suing either audio or video presentation material such as, statistical 
documents, projectors, flip charts, whiteboards etc. Firms usually make 
presentations into sales, training and internal communication programs, using 
the power of words and images to engage their audience and retain attention. 
The most common examples of the business presentations are intra-
organization and sales presentations. Generally, the suppliers conduct the 
sales presentations in front of a potential customer with the aim of pitching 
their services, whereas the intra organization presentations are conducted by 
members of a company in front of their coworkers with the purpose to 
introduce new operations or policies.  

Importance of Business Presentations: 

Business presentations are often utilized by the business as a way to sell its 
idea or product for motivating the audience to accept their offering. An 
effective business presentation helps the business to obtain market and 
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competitive information that in a way helps them to improve their business 
performances. Presentations can be used to inform executives and managers 
about the key markets and competitive strategies this can help the 
management in developing strategies and marketing plans for different 
markets as the needs. Managers can also learn more about competitive 
marketing strategies. Business presentations are important because they 
enable executives to share details on a company's performance. Performance 
information can include details on company sales and profits, market share 
and earnings per share etc. Presenting sales information allows managers to 
develop strategies to improve sales. 

There are many factors that determine the effectiveness of a business 
presentation. Some of them are stated below: 

Connecting: A business presentation must be connecting; it should be 
interactive to hold a memorable bonding experience between the 
audience and the presenter to deliver the overall message.  

Informative: A business presentation must convey a good piece of 
information to the audience and must be eye-opening and enlightening.  

Inspiring: A business presentation must be able to grab the attention of 
the audience by focusing on the important points.  

Appealing: The overall impact of a business presentation is also affected 
by using visual or physical props. Some of the factors that mostly appeal 
the audience are screen projectors, handouts, slides and body language of 
the presenter. 

Types of Business Presentations: 

Business presentations basically are of four types as stated below: 

1) Group Presentations: Group presentations are informational in 
structure; they seek to convince the audience to accept new strategies and 
programs. These presentations effectively communicate the findings of a 
team. These are often used at large corporate meetings where a senior 
executive presents the overall corporate direction followed by a series of 
staff members who present detailed strategies. 

2) Presentation Aids: Nowadays, the computer programs such as Flash 
and PowerPoint are used by the presenters for enhancing their 
presentation. PowerPoint presentations are simple, cheap and easy to edit 
and are an effective visual tool. Flash presentations, while more 
expensive, can help the audience to experience the presentation via video 
excerpts. 

3) Persuasive Presentations: Persuasive presentations seek to convince the 
audience to support a certain viewpoint. Generally, it outlines an 
organization goal or problem and then follows it by the statements for 
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detailing the present state of affairs. The presentation will lead the 
audience to that solution favored by the presenter using facts as well as 
examples from similar business situations.  For example, presentation to 
introduce a new product or service or expand plant or equipment.  

4) Informative Presentations: An informative business presentation plays 
a vital role in the advancement of any organization and focuses on 
educating the audience. It consists of marketing plan summaries and 
status report. Such presentations generally begin with an overall mission 
statement or goal, followed by specifics and action plans. 

15.4 MAKING RESEARCH PROPOSAL 
PRESENTATION 

A research proposal is a document proposing a research project. It outlines 
the entire research project and describes what is intended to investigate, how 
it will be done, and why it is important to undertake. The goal of a proposal 
presentation is to offer the presenter and opportunity to present his research 
ideas to other and receiver feedback and suggestions from them. Generally, a 
research proposal should contain all the key elements involved in the 
research process and include sufficient information for the readers to evaluate 
the proposed study. The proposal should have sufficient information to 
convince your readers that you have an important research idea, that you have 
good grasp of the relevant literature and the major issues, and that your 
methodology is sound. 

Components of a research proposal: 

A research proposal is consist of following elements: 

1) Title of the Research: In the first slide of the presentations the title of 
the research under study should be mentioned. It should be concise, 
informative and catchy enough to indicate the independent and 
dependent variables. A good title provides the "key words" for the 
classification and indexing of the research. 

2) Abstract: After the title slide, the Abstract should be mentioned on the 
next slide. Abstract is a brief summary of approximately 200-300 words 
about the research. It should summarize all the central elements such as 
rationale, objectives, methods, populations, time frame, and expected 
outcomes of the study in precise.  

3) Introduction: After abstract, next slide should state the introduction of 
the research. The introduction provides the readers with the background 
information. It should clearly state the topic area, research question and 
significance knowledge of the research.  
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4) Review of Literature: The next slide mentions the review of literature. 
In this section, we mention the most relevant and important studies 
which are already known about the topic. A strong literature review 
convinces the reader that proposal has a solid foundation in existing 
knowledge or theory and demonstrates exactly how the research will 
contribute to conversations in the field. Reviews of the literature are not 
summaries, they are arguments that there is a gap that needs filling  that 
convince the reader that research will fill these gaps or address some 
important limitation or deficiency. 

5) Objectives: After giving a comprehensive review of literature, in the 
next slide the objectives of the research proposed should state clearly. 
Research objectives are the goals to be achieved by conducting the 
research. Objectives should be logical, coherent, feasible and realistic 
considering local conditions. Objectives are known as the specific steps 
that you will take to achieve your aim. The aim is the “WHAT” of the 
research, and the objective is the “HOW”. 

6) Hypothesis: After objectives, the next slide should state the hypothesis 
of the study. A hypothesis is defined as a tentative prediction or 
explanation of the relationship between two or more variables. It is a 
tentative idea or assumption, that is proposed for the sake of argument so 
that it can be tested to see if it is true or not.  

7) Methodology: The next step in making of the research proposal is to 
state methodology. The methodology explains the procedures that will be 
used to achieve the objectives of the research. It should cover the 
approach to the question, research design, research subjects, sampling 
procedure, data needs, analytic techniques etc. 

8) Bibliography/References: After methodology, the next slide should 
state the references of the various studies, reports and data reported in the 
proposal. Generally, references are written in Vancouver style and 
should be written consecutively throughout the body of the text in the 
order in which they are first mentioned. 

9) Annexes: The last slide of the presentation should enclose the appendix 
for the study. It includes various documents such as, interview protocols, 
sample of informed consent forms, cover letters sent to appropriate 
stakeholders, official letters for permission to conduct research, original 
scales or questionnaires etc.  
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2) Step 2: Select a topic: After analyzing the audience, the presenter must 
select the topic that is of his interest and also is of interest to the 
audience. It will be much easier to deliver a presentation that the 
audience finds relevant, and more enjoyable to research a topic that is of 
interest of the presenter. 

3) Step 3: Define the objective of the presentation: Once the topic of the 
project has been selected; next step is to write the objective of the 
presentation in a single concise statement. The objective must specify 
what the presenter wants to deliver to the audience. Objectives are based 
on the level of content on the amount of time the presenter have and the 
background knowledge of the audience. Objectives guide the presenter to 
keep him focused and provide guidance to develop the presentation. 

4) Step 4: Prepare the body of the presentation: After defining the 
objectives of the presentation, next task is to determine how much 
information can be presented in the allotted time. The body of 
presentation is where the presenter can present his ideas. To presents 
ideas the presenter should use various facts and figures, relate personal 
experience and provide vivid description. The present must keep in mind 
the knowledge about the audience to prepare the presentation with the 
right level of detail.  

5) Step 5: Prepare the introduction and conclusion: Once all the 
prerequisites to the presentation are complete, the presenter should 
decide on how to begin and end the talk. The introduction must be catchy 
enough to attract the attention of the audience, and build their attention. 
Introduction must be relevant to the listeners’ goals, values, and needs 
and should clearly articulate the purpose of the presentation. Conclusion 
of the presentation must summarize the important points and reinforce 
the main ideas communicated.  

Check Your Progress A 

1) How to add speakers notes in a PowerPoint presentation? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

2) How to add a new slide in the PowerPoint presentation? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 
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3) What is a persuasive presentation? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

4) What is a research proposal? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

5) What do you understand by review of literature? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

15.6 LET US SUM UP 

PowerPoint is very useful software/tool for making presentation. It provides 
opportunity to the presentation developer/ user to incorporate various 
elements in the presentation so that it can be made effective and more 
appealing. Knowledge of the topic will help you in identifying different 
components for making presentation. When you plan to make presentation, 
first thing you have to make sure that what the available resources to be used 
in presentation.   

Business presentation is defined as any formal information about the 
business, products or practices to inform, educate, motivate and persuade 
internal and external audiences.  Business presentations are often utilized by 
the business as a way to sell its idea or product for motivating the audience to 
accept their offering. An effective business presentation helps the business to 
obtain market and competitive information that in a way helps them to 
improve their business performances. Business presentations basically are of 
four types group presentation, presentation aid, persuasive presentation, 
informative presentation. 

A research proposal is a document proposing a research project. It outlines 
the entire research project and describes what is intended to investigate, how 
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it will be done, and why it is important to undertake. The goal of a proposal 
presentation is to offer the presenter and opportunity to present his research 
ideas to other and receiver feedback and suggestions from them. A research 
proposal presentation must include important heads such as title of the 
research, abstract, review of literature, objectives of the study, research 
methodology, bibliographic references, annexes etc. 

Project presentations are made for explaining the project undertaken either to 
explain the product or to explain the process to the evaluators. The 
presentation is complemented by the project documents and product demo. 
The presenter gives the presentation to inform, persuade, inspire, motivate, or 
to build good will or to present a new idea to the audience. Project 
presentations include five steps as analyzing audience, selecting a topic, 
defining the objective of the presentation, preparing the body of the 
presentation, preparing the introduction and conclusion respectively. 

15.7 KEY WORDS 

Clip Arts: Clip Art is a collection of media files (images, videos, audio, and 
animation files) that Microsoft includes with the PowerPoint application. 

Research Proposal: A research proposal is a document proposing a research 
project. It outlines the entire research project and describes what is intended 
to investigate, how it will be done, and why it is important to undertake.  

Abstract: Abstract is a brief summary of approximately 200-300 words 
about the research. It should summarize all the central elements such 
rationale, objectives, methods, populations, time frame, and expected 
outcomes of the study in precise.  

Review of Literature: Reviews of the literature are arguments that there is a 
gap that needs filling that convince the reader that research will fill these gaps 
or address some important limitation or deficiency. 

Hypothesis: A hypothesis is defined as a tentative prediction or explanation 
of the relationship between two or more variables.  It is tentative idea or 
assumption, that is proposed for the sake of argument so that it can be tested 
to see if it is true or not. 

Business Presentation: Business presentation is defined as any formal 
information about the business, products or practices to inform, educate, 
motivate and persuade internal and external audiences. 

Presentation Aids: Computer programs such as Flash and PowerPoint used 
by the presenters for enhancing their presentation are known as presentation 
aids. 

Project Presentation: Project presentations are made for explaining the 
project undertaken either to explain the product or to explain the process to 
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the evaluators. The presentation is complemented by the project documents 
and product demo. 

15.8 TERMINAL QUESTIONS  

1) How the PowerPoint presentations are made? State the components in 
making PowerPoint presentations. 

2) What do you understand by a business presentation? Explain various 
types of business presentation. 

3) What is the importance of a business presentation? State the various 
factors determining the effectiveness of business presentations. 

4) State the various components of the research proposal. 

5) Explain the various steps involved in project presentation. 
 

Note: These questions are helpful to understand this unit. Do efforts for 
writing the answer of these questions but do not send your answer to 
university. It is only for yours practice. 

 

 

  




